
LEARNING OBJECTIVES

After reading this appendix, you will be able to:

➤ Become familiar with Microsoft Project 2007.
➤ Enter tasks, estimate task durations, and sequence tasks in

Microsoft Project.

➤ Enter resources and assign resources.

➤ Track project progress.

➤ Report project status.

Follow the directions on the Web site to install 
Microsoft Project on your computer. During the installa-
tion process, you will be asked whether you prefer 
the “typical” installation, or whether you want a “com-
plete” or “custom” installation. The typical installation 
includes the most commonly used features of Microsoft 
Project; however, if you would prefer some additional 
features (e.g., PERT analysis), choose the complete 
installation.

Microsoft Project 2007 is a Microsoft Office applica-
tion, so it has many elements similar to other Office titles 
such as Word, Excel, and PowerPoint. To begin using 
Microsoft Project, first start the application by clicking on 
the Start menu, All Programs, and select Microsoft 
Project, which is located in the Microsoft Office folder by 
default. Alternatively, if there is a program icon for 
Project on the desktop, double-click the icon to open 
Microsoft Project. The application will open with the 
screen shown in Figure A.1.

As you can see, elements of the user interface should 
be familiar to you if you’ve used Word or Excel. 
Specifically, the menu bar and the toolbar have been 
integral in Office 2003 and later, and the window 
opens with the task pane on the left side of the 
window (see Figure A.2). Depending on settings 
specific to your computer, your opening screen may not 
appear exactly as shown, but the differences will be 
minor.

Before getting started with specific project man-
agement activities, we will first explore the help menu 
and some interface characteristics that will help you 
configure Project 2007 to your preferences. 

Introduction

In keeping with the technological focus of this textbook, 
this appendix will provide you with a basic introduc-
tion to Microsoft Project 2007, a powerful project 
management software package that can help 
project staff manage schedules and resources and to 
track project progress. Although several vendors 
provide project management software (see Chapter 1) 
across a variety of price points and a variety of 
specific industries, Microsoft Project is one of the most 
widely used project management software 
applications available. Considering its 
widespread use and its familiar Microsoft Office 
user interface, we chose Microsoft Project 2007 to 
illustrate how project management software in 
general can support and facilitate information 
systems project management.

While the use of project management software can 
enhance and support the project management function, 
project management software should not be used in 
lieu of becoming familiar with the project management 
concepts presented in this textbook. This appendix is 
written with the expectation that the reader possesses 
some basic knowledge of the IS project management 
concepts presented in Chapters 1 through 12.

Microsoft Project Basics

If you do not already have Microsoft Project 2007, a trial 
version can be found online, e.g., at: http://
download.cnet.com/Project-Professional-2007-Trial-
Version/3000-2076_4-75451260.html.

456

Microsoft Project 2007 Tutorial
Appendix



Appendix A Microsoft Project Tutorial 457

Figure A.1 Microsoft Project 2007 opening screen

Microsoft Project Help
One of the most important (and underused) features of 
Microsoft Project is the Help menu. To get help in 
Microsoft Project 2007, click on the Help menu in the 
menu bar, and click on “Microsoft Office Project 
Help” (see Figure A.3), or hit the F1 key.

After clicking on “Microsoft Office Project Help,” 
the Help dialog box will open (see Figure A.4). 
The Help dialog box opens with a field to type 
questions or keywords and displays links for a 
variety of help topics. In addition to the built in 
help topics, the Microsoft Project Help dialog box 
provides links to Microsoft's Online help 
contents, including Downloads, Training, and Templates 
(see Figure A.5).

Figure A.2 Microsoft Project 2007 screen elements



458 Appendix A Microsoft Project Tutorial

Figure A.3 Help menu in Microsoft Project 2007

Figure A.4 Microsoft Project 2007 Help pane
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Figure A.5 
Online Content 
settings in Microsoft 
Project 2007

As noted above, the Help menu can be a valuable 
resource for assistance with common, and not-so-com-
mon issues. The Help menu should become the first stop 
for answers to questions that may be beyond the scope of 
this introductory appendix.

For the following section, and many others through-
out this appendix, the project being shown in the screen-
shots is adapted from the Software Development 
Template. It can be loaded by clicking on the File menu, 
then choosing “New.” The Taks pane is replaced by the 
New Project pane (see Figure A.6). 

Figure A.6 New Project pane in Microsoft Project 2007



460 Appendix A Microsoft Project Tutorial

Figure A.7 Microsoft Project 2007 Project Template dialog box

Click on the “On Computer” link under the 
Templates heading. The Templates dialog box will 
appear (see Figure A.7), then click on the Project 
Templates tab to see the templates included in 
the Microsoft Project software. Scroll down to find 
the Software Development template. To illustrate 
how Microsoft Project helps support project 
activities, the Software Development template will 
be used to show some of the features of this 
software. It may be useful for you to open the 
Software Development template to follow along.

Views in Microsoft Project

When Microsoft Project is opened, it opens by default 
into the Gantt chart view. Other views of a project also 
exist, such as a Network Diagram view. These other 
views (as well as other options) are available using the 
View menu (see Figure A.8).

The View menu includes the most commonly used 
views, such as the Calendar view (see Figure A.9), or the 
Network Diagram view (see Figure A.10). If you can’t 
find the view you’re looking for on the main View menu, 
click on the “More Views” option for a dialog box 
with all possible view choices and options for 
editing views (see Figure A.11).

For the remaining sections of this appendix, 
make sure your Project Guide toolbar is visible in 
Microsoft Project. To verify that it is open, click on 
the View menu, move your mouse down to the 
Toolbars option to open the Toolbar menu, and then 
verify the Project Guide option is checked (see Figure 
A.12).
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Figure A.8 Microsoft Project 2007 View menu

Figure A.9 Calendar view in Microsoft Project 2007
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Figure A.10 Network Diagram view in Microsoft Project 2007

Figure A.11 More Views in Microsoft Project 2007
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Figure A.12 Project Guide Toolbar view in Microsoft Project 2007

Figure A.13 Opening the Task Pane in Microsoft Project 2007



Figure A.14 Set estimated start date in Microsoft Project 2007

Microsoft Project Guide

To help you get started using Microsoft Project 
2007 to manage your project, the software has an 
embedded step-by-step guide to define the project, 
enter and schedule tasks, identify, assign, and manage 
resources, track project status, manage changes, 
and generate reports. The Microsoft Project Guide 
(see Figure A.2) is a toolbar that includes the most 
often used tools in Microsoft Project. To begin using 
the project guide, click on the Tasks button on 
the Project Guide (see Figure A.13). Note that 
while we will use the Project Guide to help you 
become familiar with the functionality of Microsoft 
Project, in reality all the activities discussed later 
may be done outside of the Project Guide, and in a 
different order than specified here.
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The Task Pane

After clicking on the Tasks button in the Project Guide, 
your screen should resemble that in Figure A.3, a new 
project with the Task Pane open on the left side of the 
screen. To get started, click on the “Define the project” 
link in the Task pane. Set the estimated start date for 
your project in the dropdown menu for the date. For 
example, in Figure A.14, the estimated start date is 
June 20, 2007.

Working Time
After choosing the estimated start date of your project, 
the next step is to define the working time for the project. 
Defining the project’s working time is a five-step 
process that walks you through setting up the general 
project working times (specific resources may be 
scheduled differently later). First, click on the “Define 
general working times” link in the Task pane to start 
the five-step process. The first screen (see Figure 
A.15) offers three calendar templates to choose from
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Figure A.16 Microsoft Project 2007 Project Working Times, Step 2

Figure A.15 Microsoft Project 2007 Project Working Times, Step 1



Figure A.17 Microsoft Project 2007 Project Working Times, Step 3

for the basic working time for the project. Default is the 
standard 40 hours a week, Monday through Friday 
schedule with weekends off. The other options are 
Night Shift, and 24 Hours. To illustrate the next steps 
in this example, we will choose the Standard schedule.

After you have made the general working time 
choice, click on the “Continue to Step 2” link at the 
bottom of the Task pane. Step 2 allows you to manipulate 
the days of the week, and if requested, the daily working 
times (see Figure A.16).

After making any needed changes, click on 
the “Continue to Step 3” link at the bottom of the 
Task pane. Step 3 allows you to specify nonworking 
time, such as holidays, or to specify hours during a 
given day that are not working hours. For instance, 
July 4 is the U.S. national holiday to celebrate 
U.S. independence. To specify that day as non-
working time, click on the “Change Working Time” 
link in the Task pane to bring up the Change 
Working Time dialog box (see Figure A.17). Next, 
click on July 4 to select it. Notice the working time 
is filled in on the right side of the dialog box (see 
Figure A.18).

To specify July 4, 2007, as nonworking time, click 
on the Exception tab and enter “July 4th Holiday” 
to select the entire day as nonworking time (see Figure 
A.19). If your organization does work on that day but
only works a half-day, as an example, click on the
"Details" button, then click on the "Working Times"
radio button, and then specify the working time for that
day in the fields provided. Figure A.20 shows the dialog
box with a morning half-day specified for July 4;
notice the date is bold and underlined, indicating that
the working time for that day has been edited.

After specifying all nonworking time during the 
estimated time of the project, click the “Continue to 
Step 4” link at the bottom of the Task pane. Step 4 allows 
you to specify the number of hours per day, the number 
of hours per week, and the number of days per month 
(see Figure A.21). Notice the instructions in the Task 
pane suggest making sure these values match those 
specified in earlier steps. This is important because 
Project calculates schedules based on hours. So, if you 
schedule the duration of a task as 2 days and the setting 
for work days is 8 hours, then Project will specify 16 
hours for that task.
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Figure A.18 Microsoft Project 2007 Project Working Times, Step 3, continued

Figure A.19 Microsoft Project 2007 Project Working Times, Step 3, continued (2)
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Figure A.20 Microsoft Project 2007 Project Working Times, Step 3, continued (3)

Figure A.21 Microsoft Project 2007 Project Working Times, Step 4

You may wish to make changes here if you have 
selected the Standard schedule but have made 
changes to the working times in Step 2. For 
example, if your organization works on compressed 
schedules, 4 days per week at 10 hours a day, making 
changes here will ensure that if you specify a task to 
take 2 days, it will be a 20-hour task rather than a

16-hour task. Once the values in this step are finalized, 
click on the “Continue Step 5” link at the bottom of the 
Task pane. The final step in the Project Working Times 
process is verification that the project’s calendar has 
been set and that resources will be scheduled based on 
the calendar that has been specified during these 
steps (see Figure A.22).



    There is an option at this step to define a 
different calendar for a different set of resources. This 
might be useful if your organization utilizes a 
pool of part-time workers, for example. If you are 
satisfied with the calendar, click on the “Save and 
Finish” link at the bottom of the Task pane.

Task Entry
Now that the calendar has been set and saved, the next 
step is to enter the tasks to develop a Work Breakdown 
Structure (WBS). First, click on the “List the tasks in the 
project” link in the Task pane to bring up the List Tasks 
pane (see Figure A.23). There are two additional options 
to consider here as well. First, there is an Import wizard 
if there is another file with tasks already listed, such as 
an Excel spreadsheet. Second, there is the option to spec-
ify a task as a milestone.
    Notice that Project suggests in this pane 
specifying durations for the tasks. You may wish 
to enter durations at this stage; however, if your 
goal is to develop a WBS (as shown in Chapter 6),

you may wish to wait until a later step to specify 
durations. Figure A.24 shows the beginnings of a 
task list with no durations specified, that is, a WBS. 
Notice at this point, that no durations and no start 
or finish dates have been specified for any tasks.

Once all of the tasks have been entered into the 
Task entry table, click on the “Done” link in the List 
Tasks pane to return to the Task pane. The next step is 
to create summary tasks that represent phases of the 
project. Click on the “Organize tasks into phases” link 
in the Task pane to bring up the Organize Tasks pane. 
Notice in the task list, the first five tasks listed involve 
issues related to scope. Considering that these tasks are 
all related, and the fifth task is a milestone referred to 
as “Scope complete,” we may wish to group these five 
tasks into a larger summary task. To do this, select 
the first task in the list, and then click on the button 
to insert a new row (see Figure A.25). For this 
example, we’ll enter the summary task’s name as 
“Scope” (see Figure A.26).
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Figure A.22 Microsoft Project 2007 Project Working Times, Step 5
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Figure A.23 Enter tasks in Microsoft Project 2007 

Figure A.24 Starting a WBS in Microsoft Project 2007
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Figure A.25 Inserting a row for a summary task in Microsoft Project 2007

Figure A.26 Entering the summary task name in Microsoft Project 2007



Now, to set the “Scope” task as a summary task, 
select the five following tasks (“Determine project scope” 
through “Scope complete”), and then click the button 
with the arrow pointing to the right to indent the 
selected tasks (see Figure A.27). Notice that the “Scope” 
task is now bold and has a black, rather than blue, dura-
tion indicator.

In Figure A.28, a row has been inserted to enter 
a summary task called “Testing,” but just entering the task 
into the row makes it appear as though it is a subtask of 
the “Development” summary task (see Figure A.29). To 
make “Testing” a summary task, click on the button (in 
the Organize Tasks pane) with the arrow pointing to the 
left. This outdents (moves the indention level to the left) 
“Testing” (see Figure A.30). Once subtasks to testing are 
identified and indented, “Testing” will then be displayed 
as a summary task (see Figure A.31).

Once all of your tasks have been organized, click the 
“Done” link in the Organize Tasks pane to return to the 
Task pane. To finalize the WBS, Project can generate WBS 
numbering codes to identify the levels of decomposition 
for each task level. To generate the WBS codes for your 
project, click on the Project menu in the menu bar, mouse
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over the WBS option, then click on Define Code (see 
Figure A.32).

Depending on the complexity of your project, and the 
level of decomposition of the tasks, you can display differ-
ent levels of the WBS by clicking on the dropdown menu 
under the Sequence heading and choosing the format of 
the numbering for that particular level. In Figure A.33, the 
formatting for the WBS numbering has been set to an 
uppercase letter, followed by a period and a number for 
subtask levels.

Next, click the OK button. To display the WBS num-
bering, select the column you would like the WBS num-
bering to be next to; in Figure A.34, this is the Task Name 
column. Next, click on the Insert menu in the menu bar, 
and click on “Column” to insert a new column to the left 
of the selected column. The Column Definition dialog 
box will open; choose WBS from the Field Name drop-
down menu. Click the OK button to show the WBS col-
umn (see Figure A.35).

Task Scheduling
At this stage, we have a completed WBS in Project that we 
can use as we estimate activity durations and determine

Figure A.27 Indenting subtasks in Microsoft Project 2007
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Figure A.28 Continuing summary tasks in Microsoft Project 2007

Figure A.29 Indented summary task in Microsoft Project 2007
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Figure A.30 Outdented summary task in Microsoft Project 2007

Figure A.31 Indenting “Testing” subtasks in Microsoft Project 2007
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Figure A.32 WBS Code definition dialog in Microsoft Project 2007

Figure A.33 Setting the WBS numbering format in Microsoft Project 2007
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Figure A.34 Insert WBS column in Microsoft Project 2007

Figure A.35 WBS with codes showing in Microsoft Project 2007



task dependencies. To set the durations of each task, 
use the menus in the Duration column, or you can enter 
any number followed by “days,” “hours,” or “months.” 
The default is “days,” so if you know the task will 
not take a full day, you may wish to enter the time 
in hours (see Figure A.36). Do not set start or finish 
times; Project will calculate these automatically. If you 
need to constrain a task to begin or end at a specific time, 
that will be done in a later step. Figure A.37 shows 
the Tasks with durations set. Notice that Project will 
not allow you to set a duration for the summary tasks 
because Project will compute these automatically. Thus, 
you only need to set the durations for tasks that are 
not summary tasks.

Once you have set the durations for all of your tasks 
(milestones remain with 0 durations), it is time to schedule 
the tasks by setting their dependencies. From the main 
Task pane, click on the “Schedule tasks” link to bring up 
the Schedule Tasks pane (see Figure A.38). Three options 
are available in this pane for setting task dependencies—
finish to start, start to start, and finish to finish. To set a 
dependency between two tasks, select the tasks in the Task 
entry table, then click on the dependency you would like

to specify. Figure A.38 shows a finish to start dependency 
for tasks A.1 and A.2.

If you need to change a dependency after it is set, 
you may change the relationship to start to finish by 
double clicking on the dependency arrow on the Gantt 
chart to bring up the Task Dependency dialog box (see 
Figure A.39). Click on the dropdown menu to choose 
from the four dependency types. Use this dialog to set lag 
times for tasks as well.

For the purposes of this running example, we will 
specify all dependencies as finish to start. If several tasks 
are sequential, you can select all of the sequential tasks at 
once and then click the finish to start dependency button 
to set the dependencies for those tasks.

Now with all of the task dependencies set, notice 
that Project has determined the start and finish dates and 
times for each task based on the project’s estimated start 
date, working and nonworking times, and task parame-
ters (see Figure A.40). Additionally, after setting task 
dependencies, the Predecessor column in the Task entry 
table is now completed.
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Figure A.36 Setting task durations in Microsoft Project 2007
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Figure A.37 WBS with task durations set in Microsoft Project 2007

Figure A.38 Setting task dependencies in Microsoft Project 2007
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Figure A.39 More dependencies in Microsoft Project 2007

Figure A.40 Task dependencies set in Microsoft Project 2007



Finally, in project scheduling, tasks may sometimes have 
specific deadlines or may not be able to begin a certain 
date. In these cases, you may wish to set a deadline for 
(or constrain) those tasks. To set a deadline click on the 
“Set deadlines and constrain tasks” link in the Task 
pane. This will open the Deadlines and Constraints 
pane. The top half of the pane can be used to set a dead-
line for a task. The bottom half can be used to set various 
types of constraints on the task. If you need to set a dead-
line for a task, select the task you wish to set the deadline 
for and then click the dropdown menu in the “Set a 
deadline” portion of the Deadlines and Constraints pane 
to select a date from the calendar. Figure A.42 shows a 
deadline being set for the Scope summary task for 
Wednesday, June 27, 2007. It might be useful to set 
such a deadline if there is slack in the schedule for that 
task but the task requires some resource that is only 
available until the deadline date.

Another option is to set a constraint on a task. By 
default, every task is set to start as soon as possible. The 
other options for constraints are shown in Figure A.42. 
For instance, you may wish to push back a task as long 
as possible, particularly one with float or slack, in which 
case you would set the constraint to start “As late as 
possible.”
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Displaying the Critical Path
At this stage, you might want to have the critical path 
shown in the Gantt chart. To display the critical path on 
your Gantt chart, from the Format menu choose “Gantt 
Chart Wizard.” The wizard will lead you through several 
steps that will allow you to make a number of changes to 
the appearance of the Gantt chart (see Figure A.43). 
Besides showing the critical path, you can choose to 
show the baseline, and on subsequent screens you can 
specify resources and dates to be shown on the Gantt 
chart as well.

When you choose to show the critical path, tasks that 
are on the critical path are shown in red. You may wish to 
change the font color of the critical path tasks in the task 
entry table as well. To change the critical path tasks’ font 
color, from the Format menu, choose “Text Styles” to open 
the Text Styles dialog box (see Figure A.44). From the Item 
to Change dropdown menu, choose Critical Tasks; then 
from the color dropdown menu, choose Red. You also may 
wish to bold and/or underline the critical tasks, which can 
be done in this dialog box as well. After you have made the 
changes you wish to make, click the OK button to return to 
the Gantt chart view (see Figure A.45).

Figure A.41 Set deadline for summary task in Microsoft Project 2007
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Figure A.42 Constraints in Microsoft Project 2007

Figure A.43 Gantt chart wizard, critical path in Microsoft Project 2007
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Figure A.44 Critical path tasks font color in Microsoft Project 2007

Figure A.45 Critical path in Microsoft Project 2007
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The Resources Pane

Now that the project has been decomposed and tasks 
have been identified, their durations estimated, and 
scheduled, it is time to identify and assign resources. To 
begin working with resources, click on the Resources 
button on the Project Guide toolbar. The Resources pane 
will open on the left side of the Task entry table (see 
Figure A.46).

Enter Resources
The first step is to identify the people and equipment 
that will comprise the resources for your project. Click on 
the “Specify people and equipment for the project” link 
in the Resources pane to open the Specify Resources 
pane (see Figure A.47). The screen now shows the 
Resource entry table and the Specify Resources pane 
gives three options for identifying resources for your 
project. If your organization maintains a company-wide 
address book (e.g., Outlook Exchange Server), or a com-
pany directory, click on the radio button next to the rele-
vant choice to bring up the dialog box to choose the 
resources to assign to the project.

For the purposes of this appendix, the following 
examples will be based on manually entering resources. 
Click on the radio button next to “Enter resources man-

ually” and begin entering your human resources into 
the Resource entry table (see Figure A.48). The columns 
allow you to enter the resource’s name, e-mail address, 
hourly rate, and overtime rate of pay. Other columns, 
such as material resources, are available and will be 
covered below.

Notice the “Entering Material Resources” link in the 
Specify Resources pane. If you click that link, detailed 
instructions will be shown in the pane on how to enter 
material resources. Several steps should be taken to enter 
material resources. First, we need to add two columns to 
the Resource entry table. Select the E-mail address col-
umn by clicking on the column heading. Next, select 
“Column” from the Insert menu to open the Column 
Definition dialog box. From the “Field name” dropdown 
menu, choose “Type” and click OK to insert the Type col-
umn (see Figure A.49).

The next column to add is the Material Label col-
umn. You can follow the steps above or, after selecting 
the e-mail address column, right click on the column 
heading and select “Insert Column” to bring up the 
Column Definition dialog box. Select “Material Label” 
from the “Field name” dropdown menu and click OK to 
insert the Material Label column (see Figure A.50). Once 
these columns have been added, enter any 
material resources needed for the project. These may

Figure A.46 Resources pane in Microsoft Project 2007
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Figure A.47 Specify Resources screen in Microsoft Project 2007

Figure A.48 Adding resources in Microsoft Project 2007
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Figure A.49 Adding the Type column in Microsoft Project 2007

Figure A.50 Adding the Material Label column in Microsoft Project 2007



include software and equipment, even transportation to 
and from the job site. Notice that when you added the 
Type column to the Resource entry table, the column was 
already filled in with “Work” for the human resources 
you had previously entered. When entering material 
resources, click on the dropdown menu in the Type field 
to select Material for that resource (see Figure A.51).

The Material Label column allows you to specify 
the cost per unit of the material resource. In the exam-
ple in Figure A.51, the project is logging costs of $10 for 
100 CD-R discs, $15 per hour of laptop computer use, 
and $.05 per page printed by the laser printer. When 
you are done entering all the resources for your project, 
click on the “Done” link at the bottom of the Specify 
Resources pane.

Define Working Time for Resources
Once the resources have been identified and entered into 
the Resource entry table, you may wish to identify 
individual working times associated with resources—
particularly those that differ from the project’s normal 
working times. For instance, you may have some people 
who are working on multiple projects within your orga-
nization and can be allocated to work on your project 
only on certain days. Or, you may have some people who
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have scheduled vacation time that needs to be accounted 
for in their working time. Microsoft Project allows you to 
specify working time for individual resources that are 
different from the project’s normal working time. 
To change the working time for a resource, click on 
the “Define working times for resources” link in the 
Resources pane to open the Resource Working Times 
pane. This is a five-step process very much like the 
process to set the project’s working time. First select the 
resource whose working time you would like to change 
and click on the “Continue to Step 2” link at the 
bottom of the pane (see Figure A.52).

The next screen allows you to select a calen-
dar template specific to that particular resource 
(see Figure A.53). For example, if you had a flex-time 
employee, you might want to choose the 24 hours tem-
plate to be able to schedule that individual during dif-
ferent hours than the project’s normal working times. 
The example in Figure A.53 will keep Anne on the nor-
mal working time schedule, but we will specify Anne’s 
vacation time in Step 4. After choosing the template for 
this resource, click on the “Continue to Step 3” link at 
the bottom of the pane.

Step 3 allows you to make changes to specific days 
and hours within the template you have chosen (see 
Figure A.54). If you are satisfied with the default settings

Figure A.51 Changing Resource type in Microsoft Project 2007



Appendix A Microsoft Project Tutorial 487

Figure A.52 Microsoft Project 2007 Resource Working Time, Step 1

Figure A.53 Microsoft Project 2007 Resource Working Time, Step 2
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Figure A.54 Microsoft Project 2007 Resource Working Time, Step 3

Figure A.55 Microsoft Project 2007 Resource Working Time, Step 4



or when you have made changes that you are satisfied 
with, click on the “Continue to Step 4” link at the bot-
tom of the pane.

Step 4 allows you to specify nonworking time for 
the resource. In the example in Figure A.55, we have 
specified Anne’s vacation time, July 16–20, by 
selecting those dates and entering “Vacation” under 
the Exceptions tab.  This automatically enters that 
time as nonworking time, however, you can make 
specific changes, like partial days by clicking on the 
"Details" button as in Figure A.21. After you have 
specified any non-working time for this resource, click 
on the “Continue to Step 5” link at the bottom of the 
pane.

Step 5 is a verification screen that the resource’s cal-
endar is now defined and gives you the opportunity to 
specify the working times of additional resources (see 
Figure A.56). You can click on the “specify working 
hours for another resource” link to do so, or click on the 
“Save and Finish” link to return to the Resources pane.

Assign Resources
Now that all the resources have been specified and 
working times have been determined, the next step is to 
assign resources to tasks. From the Resources pane, click 
on the “Assign people and equipment to tasks” link to 
open the Assign Resources pane. The Assign Resources 
pane lists four steps to assign resources to each task. The 
first step is to click on the “Assign resources” link to 

open the Assign Resources dialog box. The second step 
is to select the task to assign resources to in the Task 
entry table. The third step is to assign specific resources 
to that task. To assign resources, select the resource to 
assign and click the Assign button in the Assign 
Resources dialog box (see Figure A.57).

The first time you assign resources to a task, Project 
calculates the work required to complete the task by mul-
tiplying the duration of the task by the percentage of work 
units. For example, the “Determine project scope” task 
has originally been estimated to take 4 hours, so when 
we assign both Ajay and Anne to this task at 100%, 
Project keeps the duration of the task at 4 hours, but 
calculates that it takes 8 hours of actual work to complete 
the task—4 hours � 200% assignment units (Ajay at 100% 
and Anne at 100%) � 8 hours work (notice the circled area 
of Figure A.57). Once resources for a task have been 
finalized, any subsequent resource additions or 
subtractions will cause Project to prompt you to make a 
decision. In Figure A.58, after assigning Ajay and Anne to 
the “Determine project scope” task, we’ve decided to 
add Erica to that task as well. Notice the warning 
diamond that appears next to the Task Name field when 
Erica is added to the task. Mouse over the warning 
diamond to get the option for the drop-down menu. 
Within the dropdown menu, there are three options for 
assigning the extra resource to the task. You can 1) 
reduce the duration to keep the work the same, now
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Figure A.56 Microsoft Project 2007 Resource Working Time, Step 5
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Figure A.57 Assigning resources in Microsoft Project 2007

Figure A.58 Adding resources to a task that has already been assigned in Microsoft Project 2007



across three people instead of two; 2) increase the work 
required for the task to keep the duration constant, in this 
case, all three people now assigned 4 hours of work for 
12 total hours instead of 8; or 3) keep both the hours of 
work and the duration constant, reducing the number of 
hours that the resources work per day.

These decisions should not be made lightly. While it 
might be tempting—and in some cases advisable—to 
assign additional resources to a task to shorten its dura-
tion (effort-driven scheduling), having too many people 
assigned to a task can sometimes cause more problems 
than it solves, both administratively and financially.

Resource Views
After assigning resources to tasks, you may wish to 
explore different views of the resources that Project pro-
vides. From the View menu in the Menu toolbar, click on 
Resource Graph to view a graph of the resources and 
their percentage of allocation (see Figure A.59).

The middle pane of this view indicates which 
resource the graph represents. Use the horizontal scroll bar 
at the bottom of the pane to view other resources. The 
graph view shows the percentage of allocation for that 
resource on the dates shown. Depending on how you 
have assigned resources, you can end up with resources 
being over-allocated. This view provides an intuitive, 
easy-to-understand representation of such overallocation

by indicating overallocation with a red bar in the bar 
graph.

Another valuable resource view is the Resource 
Usage view. Open the Resource Usage view by choosing 
Resource Usage from the View menu. The middle pane 
of this view lists each resource and each task that is 
assigned to the resources (see Figure A.60). The usage 
view shows the number of hours each resource is work-
ing on each task on a given day.

More Information and Columns
The two remaining options in the Resources pane allow 
you to attach notes or hyperlinks to the resources and add 
additional columns to the resource entry table. To perform 
these tasks, click on the appropriate link in the Resources 
pane, “Link or attach more resource information” or “Add 
columns of custom information.” Follow the instructions 
in the corresponding panes to perform these steps.

After you have completed identifying, assigning, 
and managing the project’s resources, it is time to start 
tracking the progress of the project.

The Track Pane

Now that tasks have been scheduled and resources have 
been assigned, it is time to utilize Project to help you man-
age the progress of your project. First, click on the “Track
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Figure A.59 Resource Graph view in Microsoft Project 2007
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Figure A.60 Resource usage view in Microsoft Project 2007

Figure A.61 The Track pane in Microsoft Project 2007



area” link in the paragraph at the bottom of the Resources 
pane or click on the Track button in the Project Guide 
toolbar to begin tracking your project (see Figure A.61).

Save the Baseline Plan
The first step in the Track pane is to save a baseline plan 
to compare with later versions. If you have saved your 
project at any time up to this point by clicking on the 
Save icon in the toolbar or by choosing Save from the File 
menu, Project by default saves it normally, not as a base-
line plan. This is important because once the project is 
saved as a baseline plan, all subsequent changes will be 
shown in relation to that baseline plan. First, click on the 
“Save a baseline plan to compare with later versions” 
link in the Track pane to open the Save Baseline pane. If 
you have not already saved a baseline plan, the screen 
will resemble the one in Figure A.62. Click on the Save 
Baseline button to save the project as a baseline plan. If 
you have already saved a baseline plan, when you click 
on the “Save a baseline plan to compare with later ver-
sions” link in the Track pane, the Save Baseline pane will 
appear as in Figure A.63.

Notice in Figure A.63, that you can save a new base-
line or update the existing baseline, and you can choose 
to update specific tasks or the entire project. Once the 
baseline plan has been saved, the next step is to specify 
how progress on the tasks has been completed. To make

this specification, click on the “Prepare to track the 
progress of your project” link in the Track pane to open 
the Setup Tracking pane.

Setup Tracking
There are three options for setting up how progress is 
tracked throughout the project (see Figure A.64). These 
three choices relate to the level of accuracy for each 
method. According to the instructions for each option in 
the Setup Tracking pane, each option should be consid-
ered understanding its limitations.

OPTION LEVEL OF ACCURACY AND TIME CONSUMPTION

Always track  The least accurate, but fastest, method of 
by entering the tracking. Your resources will specify the 
Percent of Work percentage of work complete, between 0 
Complete (no work has been performed on the

task) and 100 (all the work has been
completed on the task).

Always track A moderately accurate and moderately 
by entering the time-consuming method of tracking. 
Actual Work Your resources will specify how much 
Done and Work work has been on each task, and how 
Remaining much work is left to do.
Always track by The most accurate though 
entering the time-consuming method of tracking. 
hours of work Your resources will specify the hours 
done per time worked on each task during each 
period time period.

Appendix A Microsoft Project Tutorial 493

Figure A.62 Saving the baseline plan in Microsoft Project 2007
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Figure A.63 Other options for saving the baseline plan in Microsoft Project 2007

Figure A.64 Setup Tracking pane in Microsoft Project 2007



Now that Project is set up to track your project’s 
progress, it is time to incorporate the progress that has 
been made on the project into the project plan.

Incorporating Progress
Depending on how you chose to track progress, there are 
three possibilities for entering progress. From the Track 
pane, click on the “Incorporate progress information into 
the project” link to open the Incorporate Progress pane. 
Begin entering the percentage of work complete for 
each task by entering the percentage in the “% Work 
Complete” column of the task entry table.

If you have chosen to track the progress of your pro-
ject by entering the actual work done and work remain-
ing, you will still set the status date but will then enter 
the amount of work done and/or the amount of work 
left to complete each task. Project provides two new 
columns—“Actual Work” and “Remaining Work”—in 
the task entry table to enter this type of progress. If 
you enter the amount of actual work done, Project 
will compute the amount of remaining work to be 
done based on the task duration you have specified

for that task. You can also enter the amount of work 
remaining, and Project will compute the amount of work 
done. However, you may wish to enter the amount of 
actual work done and the amount of work remaining. 
This can cause the task’s duration to change but may be 
necessary depending on the circumstances. Notice that 
in Figure A.66, 12 hours have been completed for the 
“Define preliminary resources” task, but we have 
determined that it will take 6 more hours to complete the 
task. This brings the total work for the task to 18 
hours, where before it was 10 hours (5 hours duration � 
2 resources � 10 hours work). Because two people are 
assigned to this task (Lee and Tamika), Project makes 
changes to the work needed to complete the task (18 
hours) and changes to the duration of the task (9 hours 
shown as 1.13 days) based on the progress information 
entered and the number of resources assigned to 
the task.

If you have chosen to track the progress of your pro-
ject by entering the hours of work done per time period, 
you will still set the status date, but the task entry pane 
will be replaced with a calendar view listing each task
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Figure A.65 Tracking progress by percentage of work complete in Microsoft Project 2007
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Figure A.66 Tracking progress by entering actual work done in Microsoft Project 2007

Figure A.67 Tracking progress by entering number of hours worked in Microsoft Project 2007
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Figure A.68 Checking progress in Microsoft Project 2007

and each resource under each task (see Figure A.67). 
In the calendar pane at the right, each resource will 
have the estimated work to be done entered in each 
“Work” row for each task. To incorporate progress 
information, enter actual hours worked for each resource 
in the “Act. W” row of each resource for each task. In 
the example in Figure A.67, on Wednesday and 
Thursday, each task has been completed in the 
number of hours estimated. Notice, however, that on 
Friday Lee and Tamika have only completed 2 hours 
each on the "Define preliminary resources" task.

Checking Progress
Now that you have begun entering progress informa-
tion, Project can indicate which tasks are on schedule, 
which are not, and which have already been completed. 
To check the progress of your project, click on the 
“Check the progress of the project” link from the Track 
pane to open the Check Progress pane (see Figure A.68). 
As with entering tracking information, you will select a 
status date for which to check the progress of the pro-
ject. Depending on the tracking information you 
entered in the previous steps and the status date you 
have chosen, Project will indicate which tasks have 
been completed, which are on schedule, and which are

behind schedule, or late, with icons in the Status 
Indicator column.

Making Changes
Once you have begun tracking the progress of your pro-
ject, you may find situations where you need to make 
changes to the project plan. Microsoft Project allows 
you to make task duration, work, and resource assign-
ment changes in one central place. To make any 
changes, click on the “Make changes to the project” link 
in the Track pane to open the Change Project pane (see 
Figure A.69). Because task duration, work, and resource 
assignments are all interrelated, changes made to one 
may impact the others, so be aware of the possible 
impacts that any change you make can have on other 
aspects of the project (see the Controlling Changes 
instructions in Figure A.69).

Now that you have begun to enter project 
progress information and have begun to track the sta-
tus of your project, you might find that the Tracking 
Gantt Chart view allows you to see at a glance how 
your project is progressing. In Figure A.70 we can eas-
ily see that the Scope summary task is almost complete 
by noticing the hash marks beneath the summary task 
indicator. We can also easily see which tasks have been
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Figure A.69 Making changes in Microsoft Project 2007

Figure A.70 Tracking Gantt chart view in Microsoft Project 2007



Appendix A Microsoft Project Tutorial 499

Figure A.71 Options in the Views and Reports pane in Microsoft Project 2007

completed by the check marks located in the first 
column of the task entry table. Notice that the bar for 
each task is split horizontally with the black bar on the 
bottom and a colored bar on top. The black bar indi-
cates the baseline plan, and the colored bar indicates 
the actual progress made for the project. In the exam-
ple in Figure A.70, no changes have been made yet to 
the project plan relative to the baseline plan. Also 
notice that once a task has been completed, it is no 
longer considered a critical path task and reverts to a 
blue bar on the Gantt chart.

The Report Pane

With the incorporation of tracking information into 
your Project file, you are now in a position to begin 
reporting your project’s progress to stakeholders 
regarding a number of project criteria. To begin analyz-
ing and reporting project information using the Project 
Guide, click on the Report button in the Project Guide 
toolbar to open the Report pane. Many of the choices in 
the Report pane we have addressed above, such as 
“Change the look or content of the Gantt chart” link. If 
you click on this link, you will be prompted to use the 
Gantt chart wizard, which we used to show the critical 
path. Clicking on the “Print current view as a report” 
link allows you to print the view that you have active 
on the screen. The options in the Print Current View 

pane allow you to shrink your entire project to fit onto 
one page or to change the settings to allow it to print 
across multiple pages. The “Compare progress against 
baseline work” link changes the current view to the 
Tracking Gantt chart view, and the “See the project’s 
critical tasks” link changes the Gantt chart to show the 
critical path.

The key feature in the Report pane is the “Select a 
view or report” link. Click on that link to open the Views 
and Reports pane. Two options are available, either 
to change the view (which was covered with the View 
Menu discussion earlier), or to create a report 
(see Figure A.71).

To select a report to print out, click on the radio but-
ton next to the “Create a project report” option in 
the Views and Reports pane Further instructions will 
appear in the Views and Reports pane that include 
“Display Visual Reports,” which provides several report 
templates, and “Display Reports,” which provides an 
intuitive interface to choose various reports in the form 
of a Reports dialog box (see Figure A.72).

From the Reports dialog box, you can choose from 
22 or more types of reports to print. Each choice in the 
Reports dialog box opens another dialog box with up to 
6 reports to choose from (see Figure A.73).

The Custom reports option gives you the opportu-
nity to make minor changes to any of the report options 
in the five previous choices. For example, if you wanted



500 Appendix A Microsoft Project Tutorial

Figure A.73 Reports to choose from in Microsoft Project 2007

to show the resources associated with each task in the 
Earned Value report, you could make those changes in 
the Custom reports dialog box. To see the Earned Value 
report as Project prints it, from the Costs option in the 
Reports dialog box, click on the Earned Value choice and 
then click on the Select button to open the Print Preview 
dialog box (see Figure A.74). Notice that Microsoft 
Project 2007 uses labels for the key values in an 
Earned Value report that might be slightly 
different than those sometimes employed in 
other project management software. Both types of 
labels were also identified and explained in the 
textbook. The following table gives their equivalents.

COMMONLY USED NOTATIONS MICROSOFT PROJECT LABEL

PV � BCWS
EV � BCWP
AC � ACWP
CV � CV
SV � SV

EAC � EAC
BAC � BAC

BAC � EAC � VAC

Also notice that the report spans several pages. The 
bar at the bottom of the window notes, “Page 1 of 4; Size: 
2 rows by 2 columns.” Also notice the arrow buttons at 
the top left of the window. These buttons allow you to 
switch to adjacent pages in the report.

We have presented the Earned Value report here as 
an example of the many reports available in Microsoft 
Project. Later, you can explore and become familiar with 
the many other available reports.

Figure A.72 Reports dialog box in Microsoft Project 2007
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Figure A.74 Earned Value report in Microsoft Project 2007
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Become familiar with Microsoft Project. Microsoft 
Project 2007 shares some common elements with 
other Microsoft Office titles, so it should be 
somewhat familiar. Major screen elements were 
noted and explained. The various Help options 
were discussed, along with additional Online 
Content settings. Project also provides several 
view options with which to see various aspects of 
the project.

Enter tasks, estimate task durations, and sequence 
tasks in Microsoft Project. The Project Guide fea-
ture of Microsoft Project 2007 makes entering 
tasks to develop a WBS simple. Once some of the 
project’s parameters, such as the estimated start date 
and pro-ject working times, are set, you can enter 
tasks directly into the task entry pane. After entering 
the tasks, you can have Microsoft Project number 
each of the tasks based on your organization’s WBS 
numbering convention. Once your WBS is set, you 
can begin entering the estimated durations of the 
tasks and you can schedule the tasks relative to 
each other by setting their dependencies. After the 
tasks have been scheduled, you can also set 
constraints on the tasks and change the Gantt chart 
view to show the critical path.

Enter resources and assign resources. Now that the 
tasks have been scheduled, it is time to specify the 
resources for the project. This involves identifying 
each resource, and for human resources, specifying 
their working rates and working times. Material 
resources are also identified and entered with two 
additional columns; the Type column that identifies 
them as “Work” or “Material” resources, and the 
material label column. Once all the resources have

been specified for the project, it is time to assign 
resources to tasks. Microsoft Project computes the 
number of hours of work needed to complete the task 
in the task’s scheduled duration by multiplying the 
duration of the task by the percentage of work 
assigned to the task. After the first assignment of 
resources to the tasks, if any subsequent resource 
assignments occur, Microsoft Project 2007 prompts 
you to decide whether to shorten the duration of 
the task, increase the amount of work to complete 
the task, or keep both the duration and work constant 
by decreasing the number of hours worked by the 
resources assigned. Microsoft Project provides 
several views with which to see and manage 
resources during a project.

Track project progress. Microsoft Project 2007 
provides many options for tracking the progress of 
your pro-ject. Once your plan is entered (tasks 
scheduled and resources assigned), you can save the 
plan as a baseline plan against which all progress is 
compared. You must decide how to enter progress, 
and then progress can be incorporated into the plan. 
If changes need to be made, Microsoft Project 2007 
provides a central place for making them to the 
schedule and/or resources.

Report project status. Microsoft Project 2007 
contains a wide variety of reporting options to 
facilitate communication with stakeholders. The 
various reports are grouped into six main 
options—Overview, Current Activities, Costs, 
Assignments, Workload, and Custom. Each main 
grouping contains a variety of reports to choose 
from that can easily be printed directly from 
Microsoft Project 2007.
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